WORD BEYOND BASICS

Learn advanced skills in Microsoft Word 2016

Making the most of Word

Once you have a handle on the ba- with your own designs. In this course,
sics of using Word, there are many we will go over using the header and
advanced features to learn for spe- footer, creating tables, adjusting in-
cialized documents. Word provides dents and tabs, and adding images
the ability to design documents with and shapes.

columns, indents, shapes, images,

and more. Many Word templates pro-
vide examples of these features. The
material we cover today will allow
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Header and Footer

The space at the top of a docu- appear grey while working in your doc-
ment above where the text ap- ument. It will not print out in grey.
pears is called the header. The This simply indicates that the header
header holds content that appears or footer is not active for editing. In
on every page. It is a good place the same way, when the header or
to include items like page numbers footer is open, the rest of the docu-
or company logos. Some academic ment’s content will appear grey to in-
papers may require the author’s dicate it is inactive .

last name to appear in the header

as well. The area along

the bottom of a document A

page below where the text %}:%Q

appears is called the footer. P—

The footer is used in the Wi youre working wth onger docuiments, 1t cam be dificut and time consutning 1 ucate a specifc word or phease.

Word can automatically search your document using the Find feature, and it allows you to quididy change waords or
phrases using Replace

same way as the header.

To find text

n our example, we've written an academic paper and will use the Find commiand to locate ol instances of a particular

To access the header or foot-
er area and add content,

word
1. From the Home tab, dick the Find command. ARernatively, you can gress CtrF on your keyboard.
2. The navigation pane will appear on the left side of the screen.
3. Type the text you want to find in the field at the top of the navigation pane. In cur example, we'll type the word
we're looking for

move your mouse cursor to [ —

the area above or below your
text and double-click. Once
the header or footer is open, messtanal

a menu for that area will ap- T
pea r 0 n th e RI bbo n a n d yo u 4, I the text & found in the document, it will be highlighted in yellow and 3 preview of the results will appear in
R the navigation pane. Alternatively, you can click one of the results below the arrows to jump to it
Wl | I be a b I e to type’ 5. When you are finished, chick the X to close the navigation pane, The highlight will dissppear,
For more search options, click the drop-dawn arrow next to the search field
add page numbers, or insert
images like a logo. Once

you are done working in the

header or footer, double- gus
click outside of the area to e
close it. Or, choose the S
Close Header or Footer m :
option on the Ribbon. The
content in the header or footer will
\
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Tables

Tables can be created in Word for nu-
merical or textual data. To create a
table, choose the Insert tab and se-
lect Table. A dropdown will appear
and with a grid representing the num-
ber of rows and columns for a table.
As you move your cursor over the
grid, a preview of the table will ap-
pear in the work area. Click on the
appropriate number of columns and
rows to create the table. Now, data
can be typed into the cells.

If you have existing data in your doc-
ument that you would like to make
into a table. Select the text and
choose Convert text to table in the
Table dropdown menu. A dialog box
will appear with options for the num-
ber of rows and columns. It will also
give the option to separate text at
Tabs, Paragraphs, or Commas.
Choose the one that matches how

your data is separated. If your data
has not been separated, try inserting
a tab between each piece of data be-
fore converting to a table and select
separate at Tabs from the dialog box.

Once you have created a table, a new
menu of options will appear on the
Ribbon including Design and Layout
features for your table. With these
options, you can choose the look of
your table and fine-tune the spacing
of cells. The Table Tools Layout tab
gives easy access to adding more
rows and columns. Rows can also be
added by selecting the plus symbol
that appears when you hover over
your table. If you right click in your
table, you will see the option for add-
ing columns or rows appear within
the text menu. Experiment with cre-
ating and editing tables to try it out.

‘rge Cell 5ize w Alignment Data
1---|--§§---|---1---|---§--|---3 e - 4 B . o e & E T
Name Email Phone
John Doe John.doe@email.com 555-555-5555
Jane Doe jdoe@example.com 555-123-4567
Sally Smith Sally 123@email.com 555-765-4321

John Smith

Johnnyll@example.com

555-555-5454

Table in Word
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Indents & Tabs

Word offers page layout control via
indents and tab stops. To utilize
this feature, you will want to make
sure your Ruler is visible. To show
the Ruler, go to the View tab and
make sure the box is checked next
to Rulers. The Ruler will indicate
the length of the document’s mar-
gins in grey. The hourglass shaped
icon on the ruler shows the current
position of the First Line Indent,
Hanging Indent, and Left Indent.
The right end of the ruler will show
a triangle that indicates the Right
Indent. When you select text and
drag one of these icons, the asso-

The Ruler glz

ciated indent for that text will change.
In addition to changing the indents,
tab stops can be used to line up text.
When you press the Tab key on your
keyboard the insertion point will jump
1/2 inch increments at a time. Apply-
ing a tab stop will -

B Tab Selector

make the tab key

jump to wherever the
tab stop is located. 0
To select a tab use

1.

the selector in the

upper left corner where the rulers from
the side and top of the document
meet.

FIRST NAME LAST NAME

Address - Phone

Email - Linkedin Profile - Twitter/Blog/Portfolio

To replace this text with your own, just click it and start typing. Briefly state your career objective, or
summarize what makes you stand out. Use language from the job description as keywords.

EXPERIENCE

DATES FROM —TO
JOB TITLE, COMPANY

Describe your responsibilities and achiewvements in terms of impact and results. Use examples,

but keep it short.

DATES FROM —TO
JOB TITLE, COMPANY

Describe your responsibilities and achiewvements in terms of impact and results. Use examples,

but keep it short.
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The Tab Selector gives the following
options:

Left Tab—Aligns text left at the tab
stop

Center Tab—Centers text at the tab
stop

Right Tab—Aligns text right at the
tab stop

Decimal Tab—Aligns numbers at
the decimal point

Bar Tab—Creates a line on the doc-

ument
L L ol
Left Tab Center Right
Tab Tab

Inserting Pictures

Adding images to a document can be
used to add color or illustration. It is
useful for creating flyers, invitations,
or posters. To insert an image into
your document, go to the Insert tab.
Choosing the Pictures button will let
you choose an image file located on
your computer. Navigate in the File
Explorer window until you locate your
image and select Insert.

If you would like to find an online im-
age, choose the Online Pictures but-
ton. This will open a window with a

N\
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First Line Indent—Determines the
length of the indent for the first line of
a paragraph

Hanging Indent—Creates an indent
in all lines of a paragraph after the first
line.

To create a tab stop, choose from the
Tab Selector and click on the ruler
where you would like the Tab Stop to
appear. If you do not select text first,
the Tab Stop will apply to the whole
document To remove a Tab Stop,
simply drag it off of the ruler.

| " 7
Decimal Bar First Line Hanging
Tab Tab Indent Indent

Bing search bar or a OneDrive option.
Bing will search the web with the
search term you provide and show
possible images. Remember to check
credit information for images from the
internet as they may be copyrighted.

The OneDrive option is available for
Microsoft account holders. OneDrive is
Microsoft’s cloud storage. If you have
an image located in your OneDrive ac-
count, you may choose this option to
navigate to it and insert it into your
document.

www.poudrelibraries.org



Working with Images

Once an image is added to your doc- Text

ument, a new tab of options appears Wrapping
on the Ribbon. These Picture |

Tools give photo editing and
stylizing options. You can apply spe-

cial effects or adjustments to make
your photo standout.

To adjust the size of your image,
drag the resize handles on the sides
and corners of the image. To main- o,

tain the same proportions, drag the ] ‘,
Prop _g Rotation Handle QQ\;

corner handles. If you would like to

rotate the image, you can choose the

rotation handle. fault is, “In line with text.” This treats

- _ _ _ the image as if it were text and keeps
Photo editing options in Word include

cropping to adjust the edges of the

it in line with text in the document. To
move the image, try changing the text
wrapping. On the Ribbon, choose the
Wrap Text option and choose a wrap-

image and color corrections. Try the
style options for some preset image

designs. ping style. Images can be placed be-
When working with images in Word, hind or in front of text. Choosing

it is important to understand how Through or Square often gives you the
they interact with text. When an im- most options for moving the image
age is added, the text wrapping de- around.

Wrapping style

o o . o d o

In line with text sguare Tight Through Top and bottom
Text Wrapping Options
EBehind text In front of text
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Shapes & Layering

Shapes can add eye-catching de-
sign elements to your document.
Shapes can be found on the Insert
tab. When you select Shapes, a
dropdown menu will appear show-
ing a variety of options. Once you
select a shape, your cursor will
change to a cross shape. Click and
drag to create the shape. Once it is
created, you can change its size by
dragging the handles along the
edge in the same way as resizing
an image. Drawing Tools will ap-
pear on your Ribbon when the
shape is selected. You can make
adjustments to your shape’s color,
edit points, and add effects.

When using shapes in your docu-
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ment, it is important to understand lay-
ering. Layering allows you to set ob-
jects, images, and text in the front or
background. If you select an image or
shape, you will see layering options on
the Ribbon. Choose Bring Forward or
Send Backward to make adjustments.
These options also have dropdown men-
us to bring items to the front or send
them all the way to the back.

Another useful feature when working
with objects is the Align option. After se-
lecting multiple objects, you can choose
to align the objects as a group. To select
multiple objects, hold down the Ctrl key
on your keyboard while you click on the
objects. The Selection Pane is a handy
tool for ordering objects as well.
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Resources for Further Learning

Continue developing computer skills
with the following resources:

Poudre River Public Library — We
are committed to supporting you as
you Connect to Curiosity in technolo-
gy tools. Take advantage of our free
assistance at a class or by stopping
by a help desk.

Recommends: Microsoft Excel and
Google Docs. Visit our resources at
https://read.poudrelibraries.org/
research/z264.html

GCF Learn Free — Quality collection
of technology tutorials free of adver-
tisements and free to use.

Recommends: Word 2016, Word Tips,
and Office for Macs. Check out cours-

LinkedIn Learning — Access to
this database of computer and busi-
ness classes is offered with a library
card.

Recommends: Learning Word and
Word Tips and Tricks. Find it on the
Library’s Research page: https://
read.poudrelibraries.org/research/

eresources.cfm?flter=alll

Microsoft Support Tutorials —
Microsoft has created several tutori-
als to help computer users get start-
ed with Word. Check out there vide-
os here: https://

support.microsoft.com/en-us/office/

word-for-windows-training-
7bcd85e6-2c3d-4c3c-a2ab-

5ed8847eae73
es at https://edu.gcfglobal.org/en/
subjects/tech/
NorthStar Digital — Tutorials and
assessments for a variety of computer
skills. Earn badges and completion
certificates.
Recommends: Microsoft Word tutorial
and assessment. Access on our com-
puter resources page: https://
read.poudrelibraries.org/research/
2264 .html
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